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Preface

This content introduces WebFOCUS Infographics, a dynamic tool that uses images to share
information and present complex concepts, such as business analytics, in a simple and
approachable manner. It is intended for WebFOCUS developers.

How This Manual Is Organized

This manual includes the following chapters:

Chapter/Appendix Contents

1 WebFOCUS Infographics Introduces WebFOCUS Infographics, and describes
how to create and edit an infographic, as well as
share it with relevant audiences.

Conventions

The following table describes the conventions that are used in this manual.

Convention Description

THIS TYPEFACE

or

this typeface

Denotes syntax that you must enter exactly as shown.

this typeface Represents a placeholder (or variable) in syntax for a value that
you or the system must supply.

underscore Indicates a default setting.

this typeface Represents a placeholder (or variable), a cross-reference, or an
important term. It may also indicate a button, menu item, or
dialog box option that you can click or select.

Key + Key Indicates keys that you must press simultaneously.

{  } Indicates two or three choices. Type one of them, not the braces.

[  ] Indicates a group of optional parameters. None are required, but
you may select one of them. Type only the parameter in the
brackets, not the brackets.

Creating WebFOCUS Infographics  5



Convention Description

| Separates mutually exclusive choices in syntax. Type one of them,
not the symbol.

... Indicates that you can enter a parameter multiple times. Type only
the parameter, not the ellipsis (...).

.

.

.

Indicates that there are (or could be) intervening or additional
commands.

Related Publications

Visit our Technical Content Library at http://documentation.informationbuilders.com. You can
also contact the Publications Order Department at (800) 969-4636.

Customer Support

Do you have questions about this product?

Join the Focal Point community. Focal Point is our online developer center and more than a
message board. It is an interactive network of more than 3,000 developers from almost every
profession and industry, collaborating on solutions and sharing tips and techniques. Access
Focal Point at http://forums.informationbuilders.com/eve/forums.

You can also access support services electronically, 24 hours a day, with InfoResponse
Online. InfoResponse Online is accessible through our website, http://
www.informationbuilders.com. It connects you to the tracking system and known-problem
database at the Information Builders support center. Registered users can open, update, and
view the status of cases in the tracking system and read descriptions of reported software
issues. New users can register immediately for this service. The technical support section of 
www.informationbuilders.com also provides usage techniques, diagnostic tips, and answers to
frequently asked questions.

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212)
736-6130. Customer Support Consultants are available Monday through Friday between 8:00
a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can
also give you general guidance regarding product capabilities. Please be ready to provide your
six-digit site code number (xxxx.xx) when you call.

Related Publications
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To learn about the full range of available support services, ask your Information Builders
representative about InfoResponse Online, or call (800) 969-INFO.

Information You Should Have

To help our consultants answer your questions effectively, be prepared to provide the following
information when you call:

Your six-digit site code (xxxx.xx).

Your WebFOCUS configuration:

The front-end software you are using, including vendor and release.

The communications protocol (for example, TCP/IP or HLLAPI), including vendor and
release.

The software release.

Your server version and release. You can find this information using the Version option
in the Web Console.

The stored procedure (preferably with line numbers) or SQL statements being used in
server access.

The Master File and Access File.

The exact nature of the problem:

Are the results or the format incorrect? Are the text or calculations missing or
misplaced?

Provide the error message and return code, if applicable.

Is this related to any other problem?

Has the procedure or query ever worked in its present form? Has it been changed recently?
How often does the problem occur?

What release of the operating system are you using? Has it, your security system,
communications protocol, or front-end software changed?

Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if you
are having problems joining two data sources, have you tried executing a query containing
just the code to access the data source?

Preface
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Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do
you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff
welcomes your opinions regarding this document. You can contact us through our website, 
http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of
training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit
our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an
Education Representative.

User Feedback
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Chapter1
WebFOCUS Infographics

An infographic is a way to convey an idea or metric in a compelling visual format. It uses
images to share information and present complex concepts, such as business analytics,
in a simple and approachable manner. Through the narratives of infographics, you can go
beyond dashboards and visualizations, and extend your communication to the level of
data storytelling, increase understanding of the subject matter, and make a lasting
impression.

This topic introduces WebFOCUS Infographics, and describes how to create and edit an
infographic, as well as share it with relevant audiences.

In this chapter:

Introducing WebFOCUS Infographics

Activating a WebFOCUS Infographics Account

Outlining Your Infographic

Creating a WebFOCUS Infographic Template

Adding Data to an Infographic Template

Replacing Data in a WebFOCUS Infographic

Sharing WebFOCUS Infographics

Introducing WebFOCUS Infographics

When you pair infographics with the power and reporting capabilities of WebFOCUS InfoAssist,
you can populate your visuals with data from your corporate sources and adopt key elements
that are specific to different audiences. You can take full advantage of WebFOCUS Reporting
Objects, which enable you to create all of your filters and WHERE conditions once and then
quickly apply them to different data elements in your infographic. You can also reuse the same
infographic template and modify it using different parameters in your Reporting Objects to
quickly show changing data narrative. Finally, use WebFOCUS ReportCaster to distribute your
message across different users, while automatically personalizing information, and applying
security rules.
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The steps that you can use to create WebFOCUS Infographics are outlined in the following
image.

Your WebFOCUS Infographic begins as an outline. Once you have determined the information
and story that you want to relay, you are ready to build a template, and create your infographic
using WebFOCUS InfoAssist in Document mode.

As you modify your infographic template, you identify and mark objects within the design so
that they can be linked to WebFOCUS data through report and chart components. When you
upload your infographic template and open it in InfoAssist, you create your infographic as a
compound document. Each object you marked in the template becomes available as a
component of the compound document. You can also leverage InfoAssist functionality to
customize your infographic further.

Introducing WebFOCUS Infographics
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The final step is sharing your infographic with your target audience. You do this by scheduling
your infographic procedure for distribution by email, FTP, to a printer, Report Library, or to the
Repository. You can also distribute sections of the infographic procedure separately to the
same or different destinations in your organization using the burst option in WebFOCUS
ReportCaster. Bursting enables you to target relevant sections of a procedure to individual
users. It uses data fields in the procedure that correspond to burst values that you specify in a
Distribution List. For more information about bursting, see the ReportCaster Guide technical
content.

For example, you may need to create and share and infographic to relay quarterly revenue,
highlight the most successful months, and identify the products that were most profitable
during that time. Using WebFOCUS Infographics, you can create an infographic similar to the
one shown in the following image, and customize it for regional managers in your company.

Because the infographic is geared for multiple regions of a retail electronics company, when
sent, it automatically shows different text and data metrics depending on the region to which it
is sent.

This content provides steps that you can use to create and share a WebFOCUS Infographic,
using sample retail data that is available to you with your installation of WebFOCUS.

1. WebFOCUS Infographics
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Activating a WebFOCUS Infographics Account

Before you can begin creating infographic templates, you must first activate your WebFOCUS
Infographics account. This activation requires you to register the site code associated with your
Information Builders account that is licensed for WebFOCUS Infographics, as well as the
corresponding email address and a password.

Procedure: How to Register a WebFOCUS Infographics Account

1. Access the WebFOCUS Infographics Sign In page in one of the following ways:

Sign in to WebFOCUS. From the WebFOCUS Home Page, click the User menu, point to
Tools, and then click WebFOCUS Infographics, as shown in the following image.

In a web browser, such as Google Chrome™, type the following address: https://
webfocus.easel.ly.

Activating a WebFOCUS Infographics Account
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The WebFOCUS Infographics Sign In page opens, as shown in the following image.

2. Under the Sign In button, click Register here, as shown in the following image.

3. When prompted, log in to the registration page using your Technical Support Center email
address and password.

Note: If you are already logged into the Technical Support Center or InfoResponse LIVE,
you will not be prompted to log in again.

1. WebFOCUS Infographics
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The WebFOCUS Infographics Registration page opens, as shown in the following image.
Here, you can manage the site codes associated with your Information Builders account,
and register the site codes that are licensed for WebFOCUS Infographics.

4. Click Register Now to register a site code that is licensed for WebFOCUS Infographics.
These site codes are denoted with a checkmark.

5. Click Manage Site Codes to add a site code to your account. This opens a new window with
options that you can use to register a new site code, as shown in the following image.

Activating a WebFOCUS Infographics Account
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Once you have added your site codes, click Back to return to the WebFOCUS Infographics
Registration page. The site codes that you added now display, and show those that are
licensed for WebFOCUS Infographics, denoted with a checkmark.

6. Upon clicking Register Now, you will receive a confirmation message and email with details
about your registration, as shown in the following image.

7. Close your browser window.

You will receive an email notification within 24 hours that provides the details you need to
activate your account.

1. WebFOCUS Infographics
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Procedure: How to Activate a WebFOCUS Infographics Account

1. Within 24 hours of registering your WebFOCUS Infographics account, you will receive an
email notification similar to the one shown in the following image.

Activating a WebFOCUS Infographics Account
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2. Click Activate My Account to access the Active Your Account page, which is shown in the
following image.

3. Type the email address associated with your WebFOCUS Infographics site code, create a
password, and click Submit.

1. WebFOCUS Infographics
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This launches the WebFOCUS Infographics powered by Easelly dashboard, where you can
choose from a library of infographics templates and get started, as shown in the following
image.

Importing the WebFOCUS Retail Sample Template

The Change Management (CM) import package with the WebFOCUS Retail Sample infographic
template is available for download from the following location:

https://webfocusinfocenter.informationbuilders.com/wfappent/infographics/

Procedure: How to Import the WebFOCUS Retail Sample Template

To import the Retail Sample infographics template:

1. Download the Infographics_CM_June14_20190614_113250_admin.zip file from the
location specified, and save it on your local machine.

2. Sign in to WebFOCUS as an Administrator.

3. From the Home Page, click Administrator and then click Legacy Home Page.

4. In the Resources tree, on the left pane, expand the Change Management node, right-click
Import, and then click Upload a Zip File from the shortcut menu.

The Upload a Zip File dialog box opens.

5. Click Browse.

The Open dialog box opens.

Activating a WebFOCUS Infographics Account
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6. Select the Infographics_CM_June14_20190614_113250_admin.zip file and click Open.

7. Ensure that the Publish Document(s) option is selected and click Upload.

8. Click OK to close the confirmation message and then click Close to close the Upload a Zip
File dialog box.

The Infographics_CM_June14_20190614_113250_admin.zip file is now listed under the
Import node.

9. Right-click the Infographics_CM_June14_20190614_113250_admin.zip file and click
Import from the shortcut menu.

The Import Package dialog box opens.

10. Select the following options in the dialog box:

In the Content Resources section, select Add New Resources Only if you do not have an
existing application folder named salesdemo or a Domain folder named Infographics/
Salesdemo Sample. If either of these locations exist, select Add New and Update Existing
Resources.

In the Security Resources section:

a. Select the Groups check box and Add New radio button.

b. Select the Import Rules on Resources check box.

11. Click OK.

When the import process completes, click OK to close the confirmation dialog box.

12. Right-click the Domains node in the left pane and select Refresh from the shortcut menu.

13. Expand the Domains node.

Ensure that the new Infographics domain node is listed.

14. Right-click the Reporting Servers node in the left pane and select Refresh from the shortcut
menu.

15. Expand the Reporting Servers node and then expand the EDASERVE node.

Ensure that the new salesdemo folder is listed and contains five images.

16. Return to the WebFOCUS Home Page and refresh the page to see the new Infographics
domain.

1. WebFOCUS Infographics
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Outlining Your Infographic

Before you begin creating any infographic, you should outline the information you want to
share, and build your story. This planning includes considering the following elements that
contribute to the success of your message.

Target audience. Define the intended recipient of your infographic, and adapt the message
to their informational needs.

Main question. Decide which question or questions your infographic answers.

Data sources. Confirm that your data answers the main question or questions, and
eliminate unnecessary information.

Logical flow. Build your story from left to right and from top to bottom - the natural way
most people consume information.

Focused view. Limit your narrative to a single topic or idea.

Call for action. Optionally, create a way for your audience to respond to your infographic
with a specific action.

While developing your outline, collect any resources to support your infographic and make sure
you have a good idea of the data that you intend to showcase. You can then create a
wireframe of your infographic to help visualize the layout and aesthetics of the final product.

Once you have created your outline, you can build an infographic template that prepares it for
use with WebFOCUS data.

Creating a WebFOCUS Infographic Template

You can begin creating your infographic template, once you have registered your WebFOCUS
Infographics account. This allows you to access to WebFOCUS Infographics powered by
Easelly, which provides a library of infographic templates, and a design tool that contains a
WebFOCUS tag option and placeholder objects that can be linked to WebFOCUS charts once
you upload your template into WebFOCUS.

You can access the Creation Tool in one of the following ways:

From the WebFOCUS Home Page, click the User menu, point to Tools, and then click
WebFOCUS Infographics.

In a web browser, such as Google Chrome™, type the following address: https://
webfocus.easel.ly.

Outlining Your Infographic
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When you sign in with your account, you can immediately begin using the extensive resource
library of templates and user-created public visuals, as shown in the following image.

1. WebFOCUS Infographics
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You can choose any template and adapt it to fit your purpose. You can also select a blank
canvas, and build your template from scratch. Once you select a template, the Creation Tool
opens. The following image shows an example of the WebFOCUS Infographics Creation Tool
view with the blank template.

You can begin to customize your infographic template using the options that are available to
you on the ribbon, which is shown in the following image.

From the ribbon, you can:

Change the default template.

Add objects, icons, images.

Add media, such as stock photos and videos.

Customize the background.

Draw lines and arrows.

Add text components.

Creating a WebFOCUS Infographic Template
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Add charts.

Note: The chart options include a WebFOCUS chart placeholder that you can fill with a
WebFOCUS chart in InfoAssist.

Upload images and icons.

Note: The supported formats are .jpg and .png.

Undo and restore your latest actions.

Display a grid for ease of formatting.

Preview your finished result.

You can use the File, Download, Share, and Resize menus, which are shown in the following
image, to save your template to your own local directory, download it in various formats, resize
it, share it, invite other users to collaborate with your design, view your template in the
browser, export your template to WebFOCUS, and modify the size of your template.

The canvas is interactive. As you drag an object from the ribbon, the canvas automatically
displays placement lines that you can use to position the object, as shown in the following
image.

1. WebFOCUS Infographics
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When you click an object on the canvas, the ribbon expands and shows additional options that
you can use to modify the object. For example, if you click a text box, the following options
become available.

The options available to you change, depending on the type of object you select. For example,
these options may include:

Lock. Locks the object and prevents you from accidently moving or deleting it. This option
is especially useful when creating backgrounds and watermarks.

Opacity. Controls transparency of the object.

Hyperlink. Adds a link to an object, making it a click-through action for the recipient.

Note: This option is not yet available for use with WebFOCUS data.

Text size and font. Modifies the font type and size of the text.

Color. Applies a custom color to an object.

Note: The color option is only available for single-tone icons and images and text objects.

Text formatting and alignment options. Customizes formatting and alignment of the text.

Position. Controls how the object is layered in relation to other objects.

Copy. Copies the object.

Delete. Deletes the object.

WebFOCUS Tag. Marks an object for data replacement in InfoAssist.

Procedure: How to Create a WebFOCUS Infographics Template

1. Sign in to WebFOCUS.

2. On the User menu, point to Tools, and then click WebFOCUS Infographics.

3. In the browser window, sign in to WebFOCUS Infographics powered by Easelly.

Note: If you have not registered your WebFOCUS Infographics account, click Register here.

4. Select a template that you want to adapt to your infographic.

Alternatively, select Blank Template if you want to build your own infographic template.

Creating a WebFOCUS Infographic Template
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For this example, we will use the Retail Company Sales template. This template comes
preconfigured to help you build an infographic that highlights revenue for a specific time
period and product categories. To add this template to your WebFOCUS Infographics
account:

a. Sign in to your WebFOCUS Infographics account.

b. Navigate to the following link: https://www.easel.ly/infographic/usr8u8

c. Rename the template to a more meaningful name.

d. Click Save to save a copy of the template to your account.

5. Edit your template to fit your requirements.

Using the ribbon options, you can manipulate a template in the following ways:

Add objects and media.

Resize shapes, images, and text.

Delete objects and sections.

Change colors.

Edit entries.

6. You can change any of the preconfigured text fields to more accurately represent what your
infographic will show. For example, the title of the Retail Company Sales template states
that it shows a revenue summary for the fourth quarter of 2018, but you could easily
change the title to instead show revenue for the first quarter. You can change the text by
double-clicking the text area and making your desired edits, as shown in the following
image.

Click anywhere outside of the text box to apply your changes.

7. As you develop your infographic, decide which objects you want to replace with data in
WebFOCUS. The Retail Company Sales template comes with objects that are already
tagged for you to replace with WebFOCUS data. These objects include:

Total Sales Revenue

1. WebFOCUS Infographics
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3 Month Sales Bar

Value of Products Pie Chart

Charger Sales

Headphone Sales

Universal Remote Sales

Tagged objects can be identified by clicking on them and seeing if they have a red star
next to them, as shown in the following image.

Note: These objects are fully customizable and are examples of the kind of data that can
be shown in your infographic.

8. To add your own tags for data objects, click these objects, and then click WebFOCUS Tag,
as shown in the following image.

The WebFOCUS Friendly Tag Name dialog box opens. Here, you can assign a name to the
object. These names appear in the InfoAssist Query pane as components, such as charts
or reports in the compound document. The more descriptive the tags, the easier it is to
identify components, and connect your data to those components in InfoAssist.

Note: You can add WebFOCUS tags to text, images, icons, or charts.

A star appears next to the object that you tagged, indicating that the tag has been applied.

9. Type a name for the tag in the Enter Tag field and click Tag.

10. You can include your company logo as a tagged object by tagging the included Information
Builders logo that is located on the bottom right of the template. In our example, we will
tag this object as Company Logo.

11. Tag any other text components that you want to fill with WebFOCUS data.

Creating a WebFOCUS Infographic Template
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12. The Retail Company Sales template comes with two placeholders already set for
WebFOCUS charts, a pie chart for Value of Products and a bar chart for 3 Month Sales, but
you can add placeholders for any additional charts you may want to add. On the ribbon,
click Charts, and then drag the WebFOCUS chart icon onto the canvas. Use the placement
lines to position your chart.

13. Optionally, add images from the library or upload your own images. You can upload images
from your machine, or select from a large array of images available as part of the
WebFOCUS Infographics toolset. To upload images, on the ribbon, click Upload, and then
click Choose Files. Select the files on your machine, and close the window. These
uploaded images are now available under the My images category of Objects. To add
images from the library, click Objects and use the drop-down list to navigate through the
available images and shapes.

For example, you can add multiple alternating map images as watermarks for each region
title that are specific to the user and the region that they are in. In the template, however,
you only need one image as a placeholder. In this sample template, an image of a map is
already designated for you. When you connect this object to data in InfoAssist, you can
create a simple DEFINE expression to automate the changing images at run time. To add a
watermark image to your template:

a. On the ribbon, click Upload.

b. Browse to a file from your machine or drag it to the Upload Files window.

c. Once you have selected the desired files, close the Upload Files window.

d. Click Objects, select My images from the drop-down list, and drag your image to the
canvas. This image will serve as a placeholder for all alternating images that we will
use in the infographic procedure.

Note: You do not need to upload all your alternating images, but make sure they are
approximately the same size.

e. Select the image on the canvas and change the opacity to be 40-50%.

f. To add a header, click Text and drag a Header object to the canvas.

g. Edit the text so it displays on top of the watermark image, by clicking the up Position

arrow  on the ribbon.

h. Add WebFOCUS tags to both the image and the header.

14. Add any extra elements that you want to include in your template, such as text objects,
dividing lines, or icons.

1. WebFOCUS Infographics
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The following image shows an example of a completed template.

15. Save your infographic with a meaningful name, in one of the following ways:

Edit the name in the control at the top of your browser window, as shown in the
following image.

Click outside the text box to save the edit.

From the menu bar, click File, and then click Save As.

Type a name for your template in the Enter a name field, and click Save.

When you return to the Creation Tool, the new name of your infographic template
appears.

16. In the header menu, click Download, and then click Export to WebFOCUS.
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The pop-up message appears, informing you that the download is ready to import into
WebFOCUS, as shown in the following image.

Note: When you download the infographic template for use in WebFOCUS, a copy of the
template saves to the Downloads folder on your machine, following the standard of each
individual browser. If you download the file more than once, it does not overwrite the
previously downloaded version, and appends it with a number that increases each time
you download it. For example, if you name your template Infographic, it saves as
Infographic.ely. If you download the same template a second time, it saves as Infographic
(1).ely. You can continue to enhance your template and infographic procedure by
overwriting the old template with your updated download. As long as the template name
remains the same, the linked infographic procedure will continue to reference it. To ensure
this link stays in place, delete the previous .ely file from the Downloads folder before you
issue a new download, or rename the template before uploading it.

Adding Data to an Infographic Template

You add data to your infographic template using WebFOCUS InfoAssist. When you open the
infographic template in InfoAssist, it becomes a compound document. Specifically, each object
that you marked with a WebFOCUS tag in the template becomes a component of the
compound document, where you can add your data. Text objects become report components,
where you can add the data field to the SUM field container or Header. Image objects become
report components that are replaced by a binary large object (BLOB) database reference, a
field reference that contains the name of an image file in a Reporting Server application path,
or an external URL. Basic chart objects become WebFOCUS grid charts, and WebFOCUS chart
objects become chart components that use the standard charting functionality available in
InfoAssist.
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You can add data to your infographic with InfoAssist in one of two ways:

Beginning with a Reporting Object, which enables you to make all of the data preparation
steps in a single place for all components in the compound document. This option enables
you to reuse filters, and modularize the development of each component in the infographic.
It also allows you to leverage a Reporting Object for reuse later.

Starting with a Master File, where you add filters and Where conditions directly in the
infographic template you open in InfoAssist. When you add data in this way, each
component is automatically connected to the Master File you select. However, you can
change the Master File for each individual component using the Add Data Source and the
Switch Data Source options. When you coordinate and burst a compound document, each
component does not need to be associated with the same Master File, but all components
must have a common data key.

Procedure: How to Add Data Using a Reporting Object

In this procedure, we will use the reporting object that came in the change management
package that was imported earlier. It can be found in the Infographics/Salesdemo Sample
domain. The reporting object comes preconfigured with a WHERE statement that specifies that
the quarter is equal to a constant value of the fourth quarter, as well as predefined filters for
the Product Subcategory field. In addition to these, the Retail IG Reporting Object comes with
four Defines already included that can be used to replace images within your template that
require personalization, such as your company logo.

1. To upload your template, sign in to WebFOCUS.

The WebFOCUS Home Page opens.

2. Navigate to the domain of your choice. On the Action Bar, click the Other tab, and then

click Upload File .

3. Navigate to the WebFOCUS Infographic template on your machine and click Open.

The file uploads to your domain folder.

4. Right-click your infographic template, point to New Infographic, and click Reporting Object.
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The Reporting Object dialog box opens and displays a list of the available Reporting
Objects, as shown in the following image.

5. In the Infographics/Salesdemo Sample domain, click Retail IG Reporting Object, and then
click Select.
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InfoAssist opens in Document mode, and your template loads on the canvas. Notice that
the WebFOCUS-tagged objects on the canvas correspond to the components in the Query
pane. In the following image, the Region image object is selected, and is shown as a
report component in the Query pane with Sum and Coordinated field containers that can
accept data values.

You can now build a WebFOCUS procedure that connects the infographic with your data.

6. On the canvas, click an object to which you attached a WebFOCUS tag. In this case, click
the Total Sales Revenue object.

The data component for this object opens in the Query pane.

7. Populate the component with appropriate data by dragging the field from the Data pane to
the Query pane or to the component on the canvas. In our example, we dragged Revenue
to the Sum field container of the Total Sales Revenue report component.
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When the canvas refreshes, it displays the data, as shown in the following image.

Notice that if you created Where statements in the Reporting Object, all your data is
automatically narrowed down to those parameters.

Note: You can use the Field Format Options dialog box to edit the format of your data to
best suit your needs. In our example, we can change the format to Integer to remove any
decimal points from our data values. You can also use the Revenue_WholeDollars
measure to obtain the same result.

8. Populate any remaining components with your data. In our example, we populated the
three Subcategory Revenue components, Headphones, Universal Remote Controls, and
Chargers, but we wanted to refine the data, so that it only showed the revenue for these
specific accessories.

For example, to populate the Headphones subcategory correctly, drag Revenue to the Sum
field container of the Headphones Sales report component, and then right-click the
individual filter in the Filter pane to enable it, as shown in the following image.

Note: In InfoAssist, you can aggregate measure fields so they display as percentages,
sums, averages, or several other value types. To do this, right-click a measure field, point
to More, point to Aggregation Functions, and then select one of the options.
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9. Populate any chart placeholders with data that is relevant to your infographic. Both basic
charts and WebFOCUS charts have corresponding field containers in the Query pane. In
our example, we can select the 3 Month sales bar chart and add the Revenue and
Sale,Month Name components to the object in order to view a chart that shows the
revenue for each month in the fourth quarter, as shown in the following image.

Tip: The Sale,Month Name component can be found under the Sales,Related dimension.
Expand Transaction Date, Simple, then expand Sale,Day, and then expand Sale Date
Details.

10. To ensure that the chart uses the colors the color scheme of your template, drag the
Sale,Month component to the Color container for the bar chart.

11. Before populating the Value of Products Pie Chart, we should first change it to a ring chart.
To do so, select the chart component and from the Format tab, in the Chart Types group,
click Other, then click Pie, and select the ring chart in the dialog box that opens.

12. Click OK to apply the chart.

13. Next, populate the chart by dragging Revenue to the Measure field container. Since we
want this ring chart to show the total value of the three subcategories listed, drag
Product,Subcategory to the Color field container.

14. Optionally, you can change the styling of the WebFOCUS chart to fit your template.

a. You can change the colors used in the chart by right-clicking any chart component,
and then clicking Series Color.

The Color window opens.

b. Select the desired color or complete the RGB information, and then click OK.

15. You can also apply different themes to your chart components. To do so:

a. Click the chart component and from the Home tab, in the Report group, click Theme.

The Templates dialog box opens.
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b. Select a theme from the available options. WebFOCUS comes with four predefined
themes, but you can also select a customized theme that matches your company's
style, as well. For our example, we will apply the style templates that are available in
the Infographics folder that was created during the change management import.

1. Select the bar chart component in your template.

2. From the Select a Theme dialog box, navigate to the Infographics folder in the tree
on the left.

3. Expand the Salesdemo Sample folder.

4. Click the Qrtly_Summary_Bar style file.

5. Click Open.

6. Click the ring chart component on your template and repeat these steps to
navigate back to the Salesdemo Sample folder.

7. Click the Qrtly_Summary_Pie style file and click Open.

c. You can also edit or remove titles from a chart to match your template formatting. To
edit a title on a chart, right-click the title and select the desired option from the
shortcut menu.

An example of the completed charts is shown in the following image.

16. Populate any remaining text or image components.

In our example, we tagged the company logo image placeholder while creating our
template, which allows you to change this image to your own company logo. The Retail IG
Reporting Object already comes with a Defined that is configured for this purpose, but this
example will walk you through how to create a Define yourself in InfoAssist.

Note: You can find the preconfigured Define for the company logo in the Sales_Related
Dimension folder under the name IBI_Logo.

a. On the Data tab, in the Calculation group, click Detail (Define).
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b. In the Define Field dialog box, link your image. In this example, we will use the
company logo image that was provided in the change management package and is
located in the salesdemo folder, as shown in the following image.

c. After you create your Define, it appears in the Data pane.

d. Add it to the Sum field container for the company logo component.

Your infographic is now set up with data for your main chart and text components. The
following procedure will show you how to set up your data so that it automatically changes
depending on the region being shown.

Procedure: How to Personalize Your Infographic for Bursting

Bursting enables you to target relevant sections of a procedure to individual users by using
data fields in the procedure that correspond to burst values that you specify in a Distribution
list. For example, because the infographic is geared for multiple regions of a retail electronics
company, when sent, it automatically shows different text and data metrics depending on the
region to which it is sent.

You can modify the image that each user sees when you burst the infographic. For example, if
you want to display an individual image for each region, you would create a Define that points
to different image files that you upload to the Reporting Server application path.

1. Ensure that your images are uploaded to the Reporting Server. You can use the Legacy
Home Page to upload them to the server path corresponding to the same domain in which
the infographic resides.
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In this example, the salesdemo folder that contains the images was created automatically
in the Reporting Server path with the change management import. To upload your own
images to a folder in the Reporting Server path, right-click the folder, point to Upload, and
click Image.

2. On the Data tab, in the Calculation group, click Detail (Define).

Note:

While the Retail IG Reporting Object already comes with this Define configured, this
example will walk you through how to create this Define yourself in InfoAssist.

You can find the pre-configured Define for the region image in the Store Dimension
folder under the name Region_Image.

a. In the Define Field dialog box, create an expression that links your image to a specific
field value. For example, if you want to show images based on the Customer Business
Region, you would create an expression to accomplish this, as shown in the following
image.

Note: The name of the Reporting Server application path that contains your images
must be defined. In this example, since the images are located in the salesdemo
folder that was created from the change management import, each file is defined as
salesdemo/filename.gif.

b. After you create your Define, it appears in the Data pane. In this example, it will be
located under the Customer dimension. You can then add it to the Sum field container
for an image component. In our case, we will add it to the Region component that is
serving as a placeholder for the map images.
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3. You can also modify portions of your text components and personalize them for bursting.
Specifically, you can insert a variable value in a line or lines of text that are custom for
each recipient.

For example, if you want to create a variable word in the introduction text component that
changes for each region when the infographic is distributed, you can do this, using the
following steps:

a. Select the intro text and from the Home tab, in the Report group, click Header &
Footer.

The Header & Footer dialog box opens.

b. Add the text that you want to modify, and drag the corresponding data field from the
Data pane to the dialog box.

Drag any field from the data pane into the canvas to incorporate it into the text.

In our example, click the Region Heading text object and replace the word EMEA with
the Store,Business,Region field, so the message reflected the region of our recipient,
as shown in the following images.

Click OK.

4. Optionally, you can coordinate components of the infographic procedure for bursting. This
means that when you apply a data value to all components, it customizes the output of
information that you send to each recipient.
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In our example, we wanted to coordinate our data by region, so each Regional Manager
received a specific revenue report narrowed down to their area. To do this, we dragged the
Store,Business,Region field in to a Coordinated field container in the Query pane, as shown
in the following image.

5. Once you have populated your infographic with data, you can run it to preview the output.
On the Quick Access Toolbar, click Run.

The infographic runs in the preview mode.

6. Save your infographic. On the Quick Access Toolbar, click Save, and then name your
infographic.

You can now share your infographic with others by email, in a form of an email burst
across different groups of stakeholders, as well as publishing or sharing it in the
WebFOCUS Repository.
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Since our example was created for bursting, the preview displays four versions of the
infographic, one for each region. In each version, the values, headlines, and images relate to
each of the four regions in our data, as shown in the following images.

You can use the same principle to generate bursts by any other field or metric, and distribute a
different infographic to different stakeholders. For example, you could distribute new versions
for each quarter, or change the Product Category represented to highlight other areas of the
product line.

Procedure: How to Add Data From a Master File

1. Create an infographic template and upload it to WebFOCUS.

2. On the WebFOCUS Home Page, right-click the infographic template, point to New
Infographic, and then click Master File.
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The Open dialog box opens and displays the list of Master Files that are available to you,
as shown in the following image.

3. Select a Master File and click Open.

The infographic template opens in InfoAssist Document mode, where you can connect it to
your data.

4. Drag data fields from the Data pane to the Query pane to add data to your components.

5. Optionally, filter your data within the InfoAssist session in one of the following ways:

a. Right-click a field in the Query pane, click Filter Values, and create a filtering condition
of your choice.

b. Drag a field from the Query pane to the Filter pane, and proceed with creating a
filtering condition.

c. Select a field in the Query pane, and on the ribbon, from the Data tab, click Filter, and
then follow the steps to create a filtering condition.

6. Save your infographic procedure.

You are now ready to share it with others.

Replacing Data in a WebFOCUS Infographic

You can modify your infographic at any time to reflect new data that is available to you. For
example, you may create an infographic that sends information monthly or quarterly. Once you
set up the initial infographic template, and Reporting Object, you can easily distribute an
updated infographic.
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In our example, we created an infographic for the first quarter of a year. You can reuse the
same template and Reporting Object for subsequent quarters without making any extensive
changes. All you need to do is modify the Reporting Object so it uses data for a new quarter. 

Procedure: How to Replace Data in a WebFOCUS Infographic

1. On the Home Page, right-click the Reporting Object you used to create your initial
infographic, and click Edit.

The Reporting Object interface opens.

2. Expand the Where Statements node and double-click an existing Where statement.

3. Modify the Where statement so that it uses your new data values. For example, if you were
creating an Infographic to reflect revenue for the second quarter, you would change the
value to April of that year, as shown in the following image.

4. Click OK.

5. Save your Reporting Object with the same name, and return to the WebFOCUS Home Page.

Note: If you rename your Reporting Object, the infographic will not run. If needed, create a
backup of the Reporting Object before you edit it.

6. If your infographic contained any static text, headings, or images related to the data for a
specific quarter, you must edit the Infographic in InfoAssist, and update those components
accordingly.

Once you have edited your Infographic, you are ready to share it with others.
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Sharing WebFOCUS Infographics

You can make your newly created WebFOCUS Infographic available to other users by publishing
it in your repository, sharing it with specific users and groups, or by distributing it using
WebFOCUS ReportCaster. You can also distribute it using the burst option, which enables you
to share specific sections of the infographic procedure with different users, based on the
coordinated field in our infographic compound document. The following steps outline how you
can share your infographic by email or burst it to members of your organization.

Procedure: How to Share Infographics

1. On the Home Page, right-click your WebFOCUS Infographic, point to Schedule, and then
click Email.

The ReportCaster Basic Scheduling tool opens, and you can specify how you want to
distribute your Infographic. You can send the same infographic or infographics to everyone
on a Distribution List or you can burst personalized instances of your infographic to
different people, based on the values in your infographic.

For more information on bursting, see the ReportCaster Guide.

2. Click Distribution, and populate the To field with the email addresses of your intended
recipients, as shown in the following image, or select a Distribution List.
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3. If you want to burst your infographic to a Distribution List, you must have access to an
existing list, or create a new one. For more information on Distribution Lists, see the
ReportCaster Guide.

You can send your infographic inline, or as an attachment, by selecting the corresponding
option under the Email Information section.

4. Click Recurrence to specify the date and time that you want to distribute your infographic.

5. If it is not already configured, you may need to enter an Execution ID and password for the
Reporting Server. Click Task to add this information.

6. On the Task pane, you must also select the Burst Report check box to distribute your
infographic separately to the same or different locations.

Note: For the Burst Report to operate successfully, you must define a coordinated value in
the infographic procedure you create in InfoAssist. Both the coordinated value and the
Burst flag are required for successful distribution of the coordinated infographic.

7. Once you have specified how you want to distribute your infographic, click Save & Close.

The Save As dialog box opens.

8. Enter the name of your schedule and click Save.

Your distribution schedule is now available from the WebFOCUS Home Page. You can edit
it at any time, or view the log file to ensure that it was successfully distributed.
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Feedback
Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented
individuals who work together to design and deliver quality technical documentation products.
Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and
services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor,
Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino,
Vice President, Technical Content Management at Frances_Gambino@ibi.com.
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